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Colours catch the attention of students and make the . 

learning interesting. Special activities are designed in 

this book, where cx child has to use crayons to display 
his/her creative skills. 

   



??? 
STORAGE 

computer stores a large 

a ount of information and 

never forgets it. 

Humans may 

forget the 

information stored 

in their mind. 

A computer 
works very fast 

and can do 
many jobs at the 

same time. 

COMPUTER - A SMART MACHINE 

- 
• Computer vs Human 

• Uses of computers in different fields 

• Types of computers 

A computer is a very useful machine. It is used almost 

everywhere, such as in schools, homes, shops, offices, banks, 

and hospitals. It has become an important part of our lives. 

A computer has some wonderful features that make it smarter 

i-han human beings. Let us know about each feature, one by one. 

Computer vs Human 

Humans need 
more time to 

do any work a 
compared to a 

computer. 



I  I_ 

Humans do not 
need any order 

to work. 

A computer 
works on a 

human's orders. 

4 Learning . 
Computers with  IPS 

A computer 

does not make 

any mistake. 

a 

Humans can 

make mistakes. 

Humans need 

rest after 
working for 

some time. 

Humans have 

feelings. 

For example, 

if you get hurt 

you feel the pain. 

A computer 

does not get 

tired and can 

work for 

tong hours. 

Humans can 
take their own 

decisions. 

A computer 
does not have 

any feelings. 

For example, 

if you hit a monitor, 

it does not react. 

WORK PROCESS 

A computer 
cannot take 

its own 
dec is ions. 



SHOPS AND OFFICES 

I 

if. 

USES OF COMPUTERS IN bIFFERENT FIELbS 

You must have seen computers at many places. They are used in almost all fields of life. 

Watching movies and listening 

to songs 

Searching for information on 

any topic 

Playing games 

Doing homework  

Keeping records of books and 

helping teachers in teaching 

Making timetable, report 

cards,and library records 

Doing practical work in lab 

Helping students to draw and 

colour pictures 

Keeping records of items 

Typing and printing bills 

Send ing and receiving messages 

in offices 

Keeping the details of bank 

accounts 

Taking out money from ATMs 



Booking tickets 

Keeping records of all 

passengers 

Giving information about 

arrival and departure timing 

Designing clothes, cars, 

machines, buildings, etc. 

Designing and printing books, 

newspapers, magazines, etc. 

Making cartoons and animated 

movies 

'V 

Keeping records of patients 

Preparing medical reports, X-

rays, etc. 

Helping doctors learn more 

about diseases and their causes 

RAILWAY STATIONS AND AIRPORTS  

DESIGNING 

Finding information about 

space 

Sending rockets into space 

Helping the military make 

security weapons 

Learning how to drive a car or fly an aeroplane 

Learning different languages, cooking, and much 

more 



This is a Desktop Computer. 

Desktop computers are big in size. 

They are kept on a desk or table. 

TYPES OF COMPUTERS 

Computers come in many shapes and sizes. 

This is a Laptop. 

It is small in size. It can be easily kept on our lap also. 

A laptop can be carried around easily. 

A  Tablet is smaller than a laptop. 

It has a touch screen on which we can write using a special 

pen. 

A  Smartphone is a mobile phone that lets you make 

calls, send messages, and store phone numbers. 

It can also be used to share pictures and videos, 

read e-mails, and search for information on the 

Internet. 



Cars 

ecords 

Orders 

Making timetable 

To book tickets 

Railways and Airports 

Shops 

SLCT!ON - A 

Fill in the blanks with the help of the hints given below. 

1. A computer works on a human  
Bills 

2. A computer is used for keeping of all items. 

3. A computer is used for designing  

4. A computer can be used for printing  

LB.c  WriteT (True) orF(False). 

1. We cannot draw pictures on a computer. 

2. besktop computers are big in size. 

3. Computers are used in offices for calculating marks. 

4. Computers are used in hospitals for preparing medical reports. 

Match the following. 

A 

To send rockets 

     

 

Tablet 

 

      

To print bills Schools 

It has a touch screen I
Space 



V.. 

SECTION - B 

{A.ç Tick the right answer. 

1.  

2.  

A  

a. Computer 

A  

a. Palmtop 

does not have feelings. 

b. Human c. None of these 

canbekeptonourlap. 

b. Laptop c. besktop 

3.  A  

a. Calculator 

lets you make calls, send messages, and store phone numbers. 

b. Smartphone c. None of these 

4.  

a. Car 

 is used to takeout the money. 

b.Tablet c.ATM 

Answer the following questions. 

1.  Name the three types of computers. 

2.  Mention any two features of a computer. 

3.  Name any two places where computers are used. 

4.  Name the computer on which we can write using a special pen. 

5.  Which device is used to make calls, share images, and store phone numbers? 



Divide the students into four groups and discuss the uses of a computer in 

different fields. 

Demonstrate to the students how to open WordPad and enter text in it. 

   

or Students 

 

   

   

Open WordPad by clicking on the Start> Windows Accessories> WordPad. 

Type the sentences given below and fill in the blanks by arranging the 

jumbled words. 

Press Caps Lock  CpLC to type in capital letters. 

Press the Spacebar key to give space between two words. 

1. I love to play games on a computer at my  

EM OH 

2. My teacher uses a computer in the  for preparing 

reportcards. L 0 H 0 C S 

3. My father uses a computer at his  
F C I F OF 

4. Computers are used in for keeping the details 

ofaccounts. N K B A S 

Save the file by clicking on the Save button or selecting the option from the 

File menu. Type any name in the File name box. 

Click on the Save button. Then, click the Close button 

Learning 
Computers with  KIPS 14 



Can take a decision 

Can work very fast 

+ 

A 
boes not need orders 

+ boes not make any mistake  +  

+ 

+ 

A. Find the activities that you can do on a computer in the word grid given 

below. Circle them with your crayons. Take help of the hints given below. 

CALCULATE 

BAEMRLELI 

ObRAWXNPC 

TETYOTTET 

YS5LPRINT 

PITYXHO&A 

EGOKAPbCK 

NNREMODSA 

OBEEYBROU 

PLAYGAMES 

• Print 

Calculate 

• Design 

• Draw 

• Play Games 

• Type 

• Store 

B. braw arrows from the boxes to the picture of a human or computer that 

they match with. 

Online Links 

 

Visit http://www.learn4good.com/kids-games/maze/funtoplay.htm  and 
kttp://www.alfatyping.com/freetyping9ames/abc-jumpers.html  

to improve your keyboard skills. 
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A. Click on the GCompris educational software. 

Click on the Search Specific Activities button 

Hunter 

— Select Photo 

Click on the differences between the two im 

> 

LLA J  LI 

There are three 

differences between the 

two images. Identify and 

click on the difference. 

One has been done for 

you. 

B. Have fun with another game. Select the activity Mathematics 

Numeration > The magician hat 

Start the game by clicking on 

the hat. Some stars will hide 

under the hat. Add the 

number of stars shown in the 

first two rows. Click on the 
correct number of stars in 
the blue boxes and click on 

ick on tPe b, ;tqI h? 



PARTS OF A COMPUTER 

• Four main parts of a computer 

• Other parts of a computer, such as Printer, 
Microphone, Speakers, and CD 

A human body is mode up of different parts. Each port has a 

spef ial work to do. In the some way, a computer is made up of 

different parts. All these parts together make a computer work. 

A computer is a machine that has four main parts: Monitor, 

Keyboard, CPU, and Mouse. 

MONITOR 

AmonitorlookslikeaTVscreen. 

- It shows the text typed in and the 

work done by us. It also displays 

the results. 

KEYBOARb  
A keyboard has many buttons, which are called keys. 

A keyboard is used for typing letters, words, 

numbers, and special symbols. 

A standard keyboard has 104 keys. 

CENTRAL PROCESSING UNIT (CPU) 

CPU stands for Central Processing Unit. 

CPU is called the brain of a computer. 

j It helps a computer to think and do all its work. 

0 0 0 

0 0 0 

0 0 0 0 0 0 

0 

0 

0 



It also helps a computer to remember things. 

All the other parts of the computer are attached to the CPU by wires. 

MOUSE 

ej 

Jj 

TYPES OF MOUSE  

A computer mouse has two buttons on it. 

It is used to point, move, and select any item on the computer 

screen or monitor. 

A mouse also helps us to draw pictures and play games. 

A mouse can be of different types: 

 

 

Two-button mouse Scroll mouse 

Scroll Mouse 

A scroll mouse has a scroll wheel in the middle of the left and right buttons. We can 

move a page up and down by moving the scroll wheel. 

A scroll mouse is of two types: 

 

A ball mouse has a ball under it. This ball helps to move the 

mouse pointer on the screen. 

 

Ball mouse 

  

An optical mouse uses light instead of a ball for the movement 

of the mouse pointer. 

   

Optical mouse 



Some commonly used printers 

MICROPHONE 

MORE PARTS OF A COMPUTER 

Apa!t from the four main parts, there are some other parts of a computer, which can 

be attached to itfordifferentfunctions. 

PRINTER 

,A printer is used to print the text or pictures on a paper. 

It can print in black and white or colour. 

The printed copy ort a paper is called the hard copy. 

A microphone is used to record our voice and different sounds into a 

computer. It also helps us to talk to our friends through the Internet. 
- 

SPEAKERS 

Speakers allow us to listen to music and hear the sound effects 

stored in a computer. 

HEAbPHONE5 

Headphones are used to listen to music as well as recorded 

sounds without disturbing others. 

S • 

 



Computer Core Tip 

Always press the keys of a keyboard gently. Hitting 

them hard can damage the inner connections. J 

COMPACT bISC (Cb) 

A CD is round in shape. It is used to store a lot of information. 

(cppQ It is a shiny disk that runs on a CD drive. 

( The CD drive is fixed in the CPU. 

HARb bISK 

Hard disk is like a box, which is fixed inside the CPU. 

, It is used to store computer data. 

PEN bRIVE 

It is a small rectangular device, that is used for transfering 

data from one computer to another. 

It is also called a Flash drive, Thumb drive, or Jump drive. 

Computer  Core Tip 

Place your computer in a coot, clean, and dry place. 

L 

4 



Pen drive I 

Mouse 

Speakers 

Headphones 

I 

I 

I 

I Monitor 

I Microphone j 

I 

I 

CPU 

Hard disk 

I 

$ 

E 

6RAI N   

SECTION - A 

Fill in the blanks with the help of the hints given below. 

1. Cbstcindsfor . 
Two 

2. A standard keyboard has keys. •  Microphone 

3. A mouse has buttons on it. • 104 

4. A  is used to record our voice into a computer.
Compact bisc 

Write  T  (True) or  F  (False). 

1. The buttons on a keyboard are called keys. 

2. Inkjet is a kind of printer. 

3. Speakers are used to record sound. 

4. A printer shows the text on the monitor. 

Match the parts of a computer with their pictures. 

   

A B 



SECTION - B 

Tick the right answer. 

1 Which one of the following is not used to store data? 

a. Keyboard b. Pen drive c. Hard disk 

2. The printed copy on paper is called the  

a. 5oftcopy b. ecord copy c. Hard copy 

3 A  helps in playing games and drawing pictures. 

a. Keyboard b. Mouse c. CPU 

4 CPU stands for  

a. Central Processing Unit b. Central Processed Unit 

c. Center Processed Unit 

LB.(  Answer the following questions. 

1. Name the main parts of a computer. 

2. Which part of a computer is used to point at and select an object? 

3. Name the computer part that is known as the brain of a computer. 

4. Which part of a computer looks like a TV? 

5. Name the device that is used for transferring data from one computer to 

another. 



A. Fill in the crossword with the help of the picture hints. 

B. Search the computer parts in the given picture and write their names in 

the given space. 

1. 00 

2.  S 7  
Si  - 

3  

ll 4. V'  I&flA1 
J 

5.  

6.  

 4 
My Name Date Teacher's Signature 
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For Teachers 

For Students 

1. Ihavemanykeys.Iama  

2. IlookIikeaTV.Iama  

3. I am the brain of a computer. I am a 

4. 1am used to record your voice.  

5. 1am used to take printout on paper. 

6. I help you to listen to music.  

A1 b 

1 I R 0 N 0 M 

rplu C 

E H R 0 M P 0 N C I 

E P I N R R T 

P K E E 5 A isi 

B 0 R K y E 

Show the different parts of a computer to the students in the lab. 

Ask them to spell each part of a computer five times. 

è bemonstrate how to put a CD in the CD Drive. 

> Open WordPad by clicking on the Start> Windows Accessories> WordPcid. 

Type the following sentences and fill in the blanks by using the jumbled 

letters, given in the blocks. 

Online Links 

 

Visit the sites:  www.quia.com/rr/33090.html  and 

http://www.thekidzpage.com/onlinej  igsaw-puzzles-htm15/ 

for solving the quiz activity. 

Visit the site: www.growing.course.com/level2/index.html  

to know about the different parts of a computer. 
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HOW DOES A COMPUTER WORK? 

       

       

       

• Real life examples of IPO 
• Input 

• Process 
• Output 

       

a 

S 

S 

0 

0 

S 

S 

I 

S 

S 

I 

S 

S 

SHARP PENCIL BLUNT PENCIL SHARPENING 

INPUT PROCESS OUTPUT 

CLEAN CLOTHES DIRTY CLOTHES 

• • . • . • . . . • • • 

A computer cannot work on its own. We need to enter letters, numbers, pictures, and 

instructions into the computer to make it work. These are called . bifferent 

parts of a computer do different tasks. A computer works in three basic steps: 

Let us understand these steps by taking an example of our body. 

When a teacher asks us a question, we hear with our ears and see with 

our eyes. The ears and eyes ore the input units. Our brain stores 

everything that a teacher says. Then, it thinks of an answer arid 

orders us to speak. In this way, the brain works like a processing unit. 

When we answer with our mouth, it works like an output unit. 

• • S S • S S I I 4 • I S S S S S S I _____________ 
• I S I S I S • S I 

0 

S 

• 

S 

• 

• • 

S S 
• S 



INPUT 

2,5,~ 

PROCESS 

2~5 

OUTPUT 

7 

• • S S S S S 

S 

, 

• S S 

• S • 
• • S 

• S 

S 

S 

S 

• 

S 

S 

S 4 S 

INPUT 

The data and instructions that we enter into a computer 

are called Input. We input data using a keyboard and 

mouse. 

H 

PROCESS 

Working on the data is called Processing. The CPU works on the data 

and does all the thinking and calculations. 

OUTPUT 

Output means the final result. When the CPU finishes 

processing the data, the output is displayed on the monitor. 

Monitor and printer are the most common output devices. 

Let us understand the working of a computer with an example. 

Example 

The data and 
instructions 

together are the 
input. Here, 2 and 5 
are the data and 

'~' 

is the instruction. 

Now, the CPU will 

work on the data 

according to the 

instructions, i.e., 

it will add the 

numbers 2 and 5. 

7 is the correct 

result or output 

of the sum: 

2~57. 



SECTION - A 

2. 

I 
• • 

I • S 
• • 

a. Output c. Input b. Process 

• • • • • S • S 
• S • • S S • • S 

• • • • S • • S S S 

. . . . . . '.7 • . . • . 

• 

S 

• 

• 

I 

I 
S 

I 
S 

S 

1 

2. 

3. 

Fill in the blanks using the words given in the hints box. 

The data that we enter into the computer is known as  

is the result given by a computer. 

When a computer works on the data, it is called  

• RAII4   

4. We enter into the computer. 

5 batacanbe , ,words,and  

  

• Output 

• Processing 

   

. Numbers 

   

batci and Instructions 

• Input 

Letters 

Pictures 

    

WriteT (True) or(False). 

bata typed into a computer is called output. 

2. A computer cannot work on its own. 

3. Monitor and printer are the most common input devices. 

4. We get output from the computer. 

1. 

SECTION  -  B 

Tick the right answer 

Which among the following parts of a computer does all the calculations? 

a. Speaker b. CPU c. Mouse 

What are the data and instructions together known as? 



S 

• • S 
S.. 
• • e 
• S 
• . 

• S 
S 

Juicer  

• S S • S S S S S S S S 
• S S S S S S S S S S S 

Stitching cloth Frock Cloth 

Juice 

S 

. 

S 
I 

S 
I 

. 

S 

3. Which part of a computer works like a human brain? 

b. Monitor c. Printer 

 Answer the following questions. 

1. Mention the three-step process on which a computer works. 

2. Which part of a computer works on data to give the output? 

3. Name the term used for the final result that we get after processing. 

4. Which part of a computer displays the output? 

Look at the pictures given below. Label the boxes with [I] for Input, {P] 
for Processing, and [0] for Output. 

IJLJ(  jj 
- _ 

Milk, Chocolate, Sugar, and Pan Chocolate milk Heating 

a. CPU 



Click on the GCompris educational software. 

Click on the Search Specific Activities  button 

Letters . 

— Select Simple 

 

     

     

Observe the falling 

letters on the screen. 

Press the key matching 

the falling letters on the 

keyboard. 

       

       

B. Click on the Search Specific Activities button  C\  — Select Count the 

items ' 

  

 

bifferent items will 

appear on the screen. 

Count the total 

number of each item. 

Type the answer in the 

box on the top-left 
side of the screen. 

  

  

   

1111111  .................. 
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OUTPUT MACHINE INPUT PROCESS 

bialing a 

number 
Telephone 

Connecting 

the number 

Washed 

c Jot h es 

Washing 

machine 

Food 

processor 

birty 

c Jot h es 

Cutting the 

vegetable 

Camera 
Setting the 

camera 
Clicking 

Calculator 

Mixer 

Numbers and 

operators 

Mango, Milk, 

and Sugar 
Churning 

Learning 
Computers with  Kips 

Take the students to the computer Jab. Show them the different input and 

output devices. 

Calculated 

answer 

Write the input, processing, and output for the following things. 

Hints: 

Chopped vegetable, leady photograph, Speaking to a friend, ig pieces of 

vegetabJe, Mango shake, Washing, Calculating 



leamViewer 5 

TeamViewer 11 

Tux of Math Command 

Tux of Math Command (Full So.. 

Tux of Math 
Command 

Start button 

TuxofMath 
Command (Full Screen),J 

Search the web and Windows 

You will get the following window. 

Click on Math Command 
Training Academy. 

Trairing Academy 

C.on - j-: rsson 

Pl Arcade C3rri 

PIy C;usom 

• •1 

• S S 

• S S 

• S S 

• S S 

• S 

S 
0 

• S 5 0 

Click on the Start icon 0 > Tux of Math Command > Tux of Math Command (Full 

Screen),.
Online Links 

bowriload Tux Math by 

visiting the site 

http://tux4kids.cl  ioth.de 

biari.org/tuxmath.php  



• Addiiori f1issuq 

As the numbers with addition symbol start falling, calculate the sum. Type the 

calculated number from the keyboard and press the Enter key to strike the 

numbers. 

Press Esc key to come back to the Main Menu. 

NOTE 

Click the light arrow to perform the other mathematical functions, like Subtraction, 
Multiplication, bivision, etc. 



UPS 
Button 

      

      

    

J
Main Power 

— Supp'y Button 
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• Steps to start a computer • Re-sizing and moving a window 
• Starting a program • How to shut down a computer? 

Students, in the previous chapters we have learnt about the parts and functions of a 

computer. Now, let us learn how to work on a computer. To start a computer, follow 

these steps: 

Switch on the main power Switch on the UPS button. 
supply button. 

S 
S 

S 
S 

Switch on the rower Switch on the monitor button and wait 
supply button of the CPU. for sometime. 

CPU Power . Monitor 
______ Button Button 

You will find a welcome screen of Windows 10. 

Students, you will enjoy working with Windows 10, as it is very easy to use. 

Windows 10 is the most popuftir program that makes the computer work. 

The first screen that appears on starting a computer is known as the Desktop. • S S 

S S S 

S S S 

• S S 

• S S 

• S 

S ' S • S S S I S S S • 
I S • S S S S S • S S 

S • • • S S S S S S S S 



- - 

- c x 
0 

Pet Pt Pitt * - 
- •it?iig t. i4.Ct 

• I P a- . '? A- jTs . 

I 

x 
0 

Control buttons 

Restore Down 
button 

P Dopitn.t - 

You can change the size of a window. 

Look at the Control buttons at the top right corner of 
the Title bar. 

34 
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S S - S S S S S S S S 
• 

S 

* The besktop holds many small 

pictures, known as icons. 

* The thin bar at the bottom of the 

desktop is called the Taskbar. 

' When you peep through your room's 

window, you can see different views. 

In the same way, you can open and view 

many programs in Windows, like Paint, 

movies, music, and games. 

STARTING A PROGRAM 

To open the WordPad program, follow the 

steps given below: 

Click on the Start > Windows 
Accessories> WordPad. 

The WordPad window will open. 

Title bar: The top-most blue bar of the WordPad window is known as the Title bar. 

RE-SIZING A WINbOW 

i Click on the middle button (iestore bown). 

The WordPad window will become small in size. 

Again click on the middle button to get back to its 
normal size. 

V • S • • • S • • S S • 
• S S • S S S S S • • 

• S S S S S S S S S S S 

• S 

S. " 
• . 

• . 

• . 

S 

Minimize 
t 1 
Close 

Maximize 

• 



Adobe PSotos... 

t U 

)J Sleep 

() Shut down 

9  Restart 

,O Type here to search 

B 

P.bhI,. Wt -h 

Click on the 

Shut down option. 

besktop Power Shut down 

• S 5 

• S S 

• • S 

• • S 

• S S 

• S 

S 

UPS 

S 

S 

S 

HOW TO SHUT bOWN A COMPUTER? 

.Af er your work is finished, you should always shut down the computer. 

Click on the 

Power button. 

CUck on the 

- 
Start button. 

Now, wait for some time till the computer turns 

of f automatically. 

Then, switch off the monitor button. 

Switch off the UPS arid the main power supply 

button. 

   

   

Computer Care Tip 

Switching off the main power supply 

button of the computer directly without 
shutting down the CPU can harm the 

computer. 

 

 

  

SECTION - A 

Fill in the blanks with the help of the hints given below. 

1. To start a computer, we need to first switch on the supply button. 

2. If the electricity goes off, the  makes the computer work. 

3. To turn off the computer, click on the Start> Power>  button. 

4. Windows is the most popular  that makes the computer work. 

5. is the first display screen when we switch on a computer. 

. 

. 

• Program 

• • • S • S S S S S 

S 5 0 5 5 S • • • S S 

• S S S S S S • S 5 



A 

1 

I- 

Icons 
2 

besktop 
I 

[ 
Tusk bar 

Minimize 

-Th 
The top-most blue bar of an application

2  

Small pictures on the desktop 

Control button
J 

The thin bar at the bottom of desktop 

a. Title bar 

a. Taskbar b. Title bar c. Menu bar 

c. besktop b. Icons 

8. The first display screen of the Windows 10 is called  

. 

S 

• S • S S S S S S S • • 
• • • • S • • S S • S S 

?. Write T(True) orF (False). 

1. You can only read the items, if the WordPad window is active. 

2. Icons are the background display of the desktop. 

3. The Title bar is located at the top of the desktop. 

4. The first step to start a computer is to switch on the monitor button. 

LC.c  Match the following. 

2 

Title bar 
C 

The first display screen 

SECTION - B 

A. Tick the right answer. 

1. makes a computer work when the electricity goes off. 

a.CPU b.UPS c. Both aund b 

2. button on the Title bar makes the WordPad window small in size. 

a. Restore down b.Close c. Minimize 

   

3. The thin bar at the bottom of the desktop is called  



• • . . S S S • S S • S 
S S S S • S • • • S S 

S 

: : Answer the following questions. 

1. What is Windows? 
S - 

S S 

2. Which button do we click first to shut down a computer? 

3. What is besktop? 

4. Whatarelcons? 

A. How to shut down your computer? 

Number the steps, from 1 to 6 us you shut down a computer, in the blank oval spaces. 

L 

A 11 

e 
Mo i. 

S M 

Th 

. 

S 

__t__  C.

I 

4  0 
• 0 

: 

0 0  • 

S 
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The water level rose up. 

• ••••..S••• 

4., 

 ••.•••• 
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RECALL THE STORY 

Read the lines of the famous story, "Thirsty Crow". Rearrange the 
sentences in correct order and then type them in WordPad. 

The crow picked up stones and dropped them, 
one by one, into the pot. 

• • 
I • S 
• S 
• . 

S S 

There was a little water in the pot. 

°nce there Was a 
Crow who was 

Very thirsty. 

• . 
• . 
S S 

• S 
• S 

5.OSSSSS • S S • S S S S • 

ning 
jwith  (PS • • • S • S • 
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Thirsty Crow 
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Chapters 1-4 

A. Fill in the blanks. 

1.  is the result given by a computer. 
Instruction 

2. The most common output devices are monitor and ..............................................• 

3. Iftheelectricitygoesoffthe makesthecomputerwork Printer 

4. The CPU works on the data according to the ..............................................
.Output 

B. WriteT(True) or(Fcilse). 

1. A computer can do many jobs at the same time. 

2. A laptop can be kept on our lap. 

3. CPU stands for Central Programming Unit. 

4. IDesktop is the first display screen on a computer. 

C. earrange the jumbled words to form the parts of a computer. 

ON 

RTP  

BAj[j 

T M I [0 R 

R N I 

K y E 

E M 0 

 

 

rH  P N 0 E L C M L0 

 

       

b. Mark the following statements in the correct order to start a computer. 

Switch on the power supply button of the CPU. 

Switch on the monitor button and wait for some time. 

Switch on the main power supply button. 0) 
Switch on the UPS button. 0) 

 



  

Chapters 1-4 

    

      

A Choose the right answer. 

1. Which part of a computer works like a human brain? 

a. CPU b. Keyboard 

2. Which part of a computer is used to input the data? 

a. Keyboard b. Mouse 

    

  

c. Mouse 

 

    

    

  

c. Bothacindb 

 

    

3. Which device lets you make calls, send messages, and store phone numbers. 

a. Printer b. Smartphone  c. Scanner 

4. What do we call the bar that is placed at the bottom of the desktop? 

a. Title bar  b. Toskbar 

. Answer in one word. 

1. Which type of a computer has a touch screen? 

c. Menu bar 

2. Name the part of a computer that is used to point and select the objects.  

3. Which button do we click first to shut down a computer?  

4. Name the mouse with a ball under it.  

C. Answer the following questions. 

1. Name the different types of computers. 

2. Mention the three - step process on which a computer works. 

3. Name the screen that appears on starting a computer. 

4. Write the names of any two places where computers are used. 

5. What is Windows 10? 



• Knowing a keyboard 

• Alphabet keys 

i#ricis. 

Number keys 

Special keys_J 
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Up 
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Spacebar Key 

Keyboard 

Arrow Keys Enter Keys Caps Lock Key 

THE KEYBOARD AND ITS FUNCTIONS 

A keyboard is an important part of the computer. It has many keys on it. These keys 

are used to type letters, numbers, and symbols. 
Numeric Alphabet Delete Numeric 

Keys Keys Key Keys 

A HABET KEYS 

Alphabet keys have letters on them from 

A' to 'Z', but they are not given in order. 

Alphabet keys are 26 in number. We can 

type letters, words, and sentences with 

the help of Alphabet keys. 

E R T Y( Uii  o 

SIDHFIG H  JIK 

J 1!I 1I ( 1J J iI 
Alphabet Keys 

Type: Name:  

Press the keys that spell your name you will find your name on the 

screen. 
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INum I I 
2' LLI L:J 0 

IJmeI LJ — III I 
'1 

III L III I_i 
P—I 

ri m 
& LJ I2' 

lins 0 

Numeric Keypad 

Enter 

Spacebar 

NUMBER KEYS 

Number keys hove numbers on them. These are 10 in numbers, that is, from 0 to 9. 

Number keys are present above the alphabet keys and are placed in order. We can 

type our age, roil number, house number, etc., by using these keys. 

1 

 

2 L 

 

A 

6 

 

7 iv" 

Number Keys 

The Number keys are also present on the right side of the 

keyboard. This is called the Numeric keypad. 

Type your loII Number:  

Press the Enter key. The cursor will move to the 
next line. (A cursor is a small blinking line on the 
screen.) 

> Now, type your age. 

SPECIAL KEYS 

These keys have different symbols on them, like: 

+ - * / " : ; ' \ I' ® # $ % - & ( )_ { ) [ ) ? >< 

There are some more keys on the keyboard, known as Special keys. 

Let us learn about them. 

Spacebar Key 

The Spacebar key is the longest key on the keyboard. 

It is used to give space between the words. 

Let us type a sentence: myriameiskabir. 

' Now, press the Spacebor key once between the words to give a space. 

Output: my name is kabir. 



Activity-4 

t 

Caps Lock Key 

T+ 
Caps Lock key is used to type letters in capitals. 

When you press the Caps Lock key once, the Caps Lock light will turn on. 

 

Caps Lock 

Type: I LIKE MY SCHOOL. 

Press the Caps Lock key again. The Caps Lock light will turn off. Type the sentence 

again and see the difference. 

Enter Key 

The Enter key is used to bring the cursor to the next line on the 

monitor. A keyboard has two Enter keys. 

 

Enter 

Type: IAMINCLA55II. 

Press the Enter key once. The cursor will jump to the next 
line. 

 

Enter 

 

Arrow Keys 

There are four arrow keys that help to move the cursor on the screen. 

t Up Arrow key is used to move the cursor up. 

4- bown Arrow key is used to move the cursor down. 

+ Left Arrow key is used to move the cursor left. 

4 Right Arrow key is used to move the cursor right. 

Backspace Key 

The Backspace key erases the letters to the left side of the cursor. 
Backspace 



Type: I LIVE INN IDELHI. 

Where is the cursor now? It is after the word, 'bELHI'. 

Press the Left Arrow key and bring the cursor after the word, 'INN'. 

Press the Backspace key to erase the extra 'N' from the word INN'. 

belete Key 

The belete key erases the letters to the right side of the cursor. 

 

Delete 

Type: I LIKE TO EAT MANGGOES. 

To delete the letter G in the sentence, move the cursor using the Left arrow 

key to the left of the letter G. 

Press the belete key. The letter G will be removed. 

SECTION - A 

Fill in the blanks with the help of the hints given below. 

1. A  is a small blinking line on the screen. 
• Enter 

2. 5pacebarkeyisthe keyonthekeyboard.
• Backspace 

3. The key is used to move the cursor right. 

4. The key erases letters to the left side of P.ght Arrow 

the cursor. Longest 

5. The key brings the cursor down to the next line. 

A' 



Backspace 

_ Iti 

I4I 141 H I.. 

Caps Lock 

Delete 

Enter 

Enter key 

Delete key 

Space bar 

Arrow keys 

Caps Lock key 

Backspace key 

7  Match the following pictures with the given words. 

SECTION - B 

T4.(  Guess! Which key am I? 

1. I type the letters in capital.  

2. I erase the letters to the right side of the cursor.  

3. I move the cursor to a new line.  

4. I give space between the words.  

Bi Tick the right answer. 

1. How many Alphabet keys are there on a keyboard? 

b. 62 c.20 a. 26 

2 How many Arrow keys are there on a keyboard? 

b.4 

3 How many Enter keys are there on a keyboard? 

a.1 b.2 

4. Which keys help us to move the cursor on the screen? 

c. 3 

c. 3 

a. 5 

a. Arrow b. Caps Lock c. Spacebar 



For Teachers' 

Open the WordPad application by clicking on the Start > Windows 

Accessories > WordPad. 

Type the following sentences in WordPad. 

1. Mynameis  

2. I study inn schhool. 

3. I have brother(s) and  sister(s). 

4. My father's name is  

5. Heisa  

6. Mymother'snameis .Sheisa  

7. I obbey my parents and teachers. 

8. I Jove my teachers and family very much. 

(INsTRucTIoNs) 

- Press the Enter key Ener  at the end of each sentence. 

Use the Arrow keys and correct the spelling of 'inn' and 'schhool' using 

the Delete key. 

In the same way, correct the spelling of 'brother'. Replace 'a' with 'o' in 

the word 'brother'. 

Use  Arrow keys and erase the extra 'b' in the word 'obbey' using the 
Backspace key. 

Click the Save button . Type the file name in the File name box and 

click on the Save button. 

Learning 
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2.  5. 

3.  6. N M 

1. FAR 3.  

4.  

L"A..t:t Pt CJLIJ 

A. The following keys are present on the left side of the keyboard. Make 

some words out of the keys given below. 

OWE R T 

A S D F1jG 

z x  cI[viIB 
B. Make some words out of the keys present on the right side of the 

keyboard. 
_I . 

1UP 4  U 10 P 

C. Rahul has an old computer. Some keys of its keyboard have faded. Kindly 

help him to paste the stickers with their names on the respective keys. 

a a a 

naann.nna. 

7 _ _ 
[2 JV 

H 4. 

n H 5. 

j 

My Name Date Teachers Signature 

H J K L 
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LEARNING IN THIS CHAPTER 

What can we do with MS Word? 

• Starting Word 2016 

• Creating a new document 

• Entering and selecting text in a document 

• Adding, saving, closing, opening, and 
printing a document 

. 

Alarrns& Clock 

Click on 
Start button. 

P Type here to search Search the web and WAndows 

USING MS WORD 2016 

Microsoft Word is a word processing software. As we use a notebook to write words 

and sentences, similarly in a computer we use MS Word to type the text in a document. 

WHAT CAN WE bO WITH MS WORb? 

Type and format the text 

Edit text, such as adding, deleting, copying, and moving 

Add pictures in a document 

Save a document for future use 

STARTING WORb 2016 

This opens the Word 2016 Start Screen. Now, select the Blank document to create a 

new document. 
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AaBbC 
Heading 1 

    

Editing 

 

Ribbon - 

Vertical 
Scroll Bar 

TITLE BAR 
Documenti  -  Word 

QUICK ACCESS 
TOOLBAR 

1.3 0 

RIBBON 

FILE TAB 

The various parts of Word 2016 window are: 

Quick Access Documenti - Word 

Fite Rome Inse Tool bar t References Mailings Rev 
Title Bar 

File Tab Command:±- 
AaBbCcDc 

—J 

AaBbCcDc 

Paste
• B I U ac X. X J;'. . II Normal  ii No Spac... - i ¶ 

Clipboard r, Font Paragraph Ses 

L 
Groups 

Ribbon Display 
Option 

Rulers  

Work Area 

Horizontal 
Scroll Bar 

 

1 
Zoom 
Slider 

  

Page 1 of 1 0 words U? 

Components of Word 2016 Window 

The Title bar is placed at the top of the Word 2016 window. It 
displays the document name followed by the program name. 

It is placed at the top left of the Word 2016 window. It contains 

the Save, Undo, and Redo commands. 

The Ribbon contains several tabs on it, such as File, Home, Insert, 

Page Layout, etc. Each tab has commands that are arranged into 

groups. 

The File tab is placed at the upper left corner of the Word 2016 
window under the Quick Access Toolbar. We can create, open, 
save, and print a file by selecting the File tab. 



RULER 

Creating a B!ank Document 

New 

to. o.o. IpoL. p 
Do.i5do I&,MIOO Fwnt 

I 

The horizontal ruler is placed at the top of the doucment window. It 

measures the width of the document page. The vertical ruler 

measures the height of the Work Area. It is located to the left of 

the document window. 

S 

S 

WORKING AREA  This area is used for typing and editing the text. 

STATUS BAR 

It is displayed at the bottom of Word 2016 window. Here, you can 

see information about the current document, like the number of 

pages, number of words, view buttons, zoom slider bar, etc. 

There are two scroll bars in the Word window - the vertical 

scroll bar and the horizontal scroll bar. The horizontal scroll bar 

moves the screen display towards right or left, and the vertical 

scroll bar is used to move the document window up or down. 

SCROLL BARS 

I I J 

ZOOM SLIbER 
It is present at the extreme right corner of the Status bar. You 

can drag the zoom slider towards right to enlarge or left to reduce 

the size of the Word document. 

CREATING A NEW bOCUMENT 

Click on the File tab. Select the 

New option in the left pane. 

Then, click the blank document 

on the right side pane. 

A new blank document will 

appear on the screen with its 

temporary name as ocument1. 

Tip You can also create a new document by using the Ctrl ~N key combination. 



New 
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Aa Title U 
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Type the following Text 

Happy Birthday 

bear friends 

I am celebrating my birthday at my 

residence on 16th November at 5 pm. 

You are invited. Kindly reach on time 

to enjoy the party. 

r 

Happy Birthday 

Dear friends 

I am celebrating my birthday at my residence on 16th 

November at 5 pm. 

You are invited. Kindly reach on time to enjoy the party. 

\hen we create a new document in Word 

2Q13, the Start Screen looks as shown in 

the given figure. 

Word 2013 

ENTERING TEXT IN A bOCUMENT 
 Creating a Blank Document in Word 2013 

Once the new document is open, you can start typing in the document using the 

keyboard. 

While typing do not press the Enter 

key when you reach the end of the 

line. 

Keep on typing the text, you will 

find that the cursor automatically 

gets shifted to the next line. This 

feature of Word is called 

Word Wrap. 

To start a new paragraph, simply press the Enter key. 

SELECTING TEXT IN A bOCUMENT 

Place the cursor before the text you wish 

to select. 

Hold down the left mouse button and drag 

the mouse over the text to be selected. 

Release the mouse button. The selected 

text gets highlighted as shown in the 

figure. 

Selecting Text in a Document 



Save As 

OneOrive 

ThtnPC 

4- 

This Week 

Oownoods 

Last  Week 

r Desktop 

Documents 

Browsejolder 

CoretDRAWGraphks5uiteX7tnstalIe. 
omen deogn . CneeI000W. 

Srows• 

AbbING NEW TEXT 

Place the cursor at the point where you want to add the new text. 

Start typing the required text. 

The typed text will appear in the document. 

 

To delete a character, select the text and press the belete key from the 
keyboard or erase the text using the Backspace key. 

 

SAVING A bOCUMENT 

Click on the Save button on the Quick Access Toolbar. Or 

ClickontheFiletab andselectthe5aveoption. 

The Save As  screen appears when you save for the first time. Notice that the Save 

As screen is divided into three panes. 

You can save your file using any of the options given in the centre pane. 

3  One Drive Add a place 

This PC Browse 

Click on the Browse button. 

The Save  As  dialog box will open. 

Select the location where you want 

to save the file. Type any name for 

your file in the File name box, e.g., 

Birthday Invitation. 

Click on the Save button. 

The file name "Birthday Invitation" 

appears in place of bocumenti on the 

Title bar. 

Save As Dia'og Box 



L Word 2013 

[10 save a document in Word 2013, click on the FILE tab and select the Save option. 

The shortcut key to save a document is Ctrl + S. 

x 
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CLOSING WORb 2016 

Click on the File tab and select the  Close  option. 

If the changes in a document are not saved, Word 2016 will prompt you to save 

the changes. 

 

The shortcut key to close a document is Ctrl +  W. 

The shortcut key to close the Word application is  Alt + F4. 
You can also exit the Word application by clicking on the Close button 

on the Title bar. 

You should close a document only after saving it. 

Word 2013 

In Word 2013, you can close the document either by using the above given shortcut keys 
0 r by clicking on the FILE  >  Close option. 

OPENING A bOCUMENT 

Click on the File tab, select the Open 

option in the left pane. 

The Open document screen appears. This 

window is divided into three panes. 

Open  Dialog Box 



Print 
cP.. 

Printer 

iM 

thn 

'-i""- 
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Click on the FILE> Print option to print the document in the Word 2013. 

Printing a Document 

The shortcut key to print a document is Ctrl+P. 

Wo d 2013 

+ In the center pane click on the Browse button. The Open dialog box will appear. 

Select the file and click on Open button. 

Word 2013 

In Word 2013, you can open the document by selecting the FILE> Open option. 

PRINTING A bOCUMENT 

To print a document: 

Click on the tab and select the Pi option from the displayed menu. 

You would see the preview of your document on the right side of the screen. 

Now,clickonthe buttoninthecenterpane. 
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Fill in the blanks with the help of the hints given below. 

Microsoft Word is a software. 

The Word application opens a blank document with the temporary name 

3. The bar displays the name of the document 

followed by the program name. 

4. The bar is present at the bottom of Word 2016 window. 

5. The scroll bar moves the screen display towards right or left. 

    

'Status Horizontal Word Processing bocumenti 

  

'Title 

 

    

     

1B. Write  T  (True) or 
II 

(False). 

1. The shortcut key to close the Word application is Ctrl + F4. 

2. The Title bar contains the buttons for saving a document. 

3. You should close a document without saving it. 

4. The shortcut key to print a document is Ctrl + P. 

5. The File tab is placed above the Quick Access Toolbar. 

Match the following. 

A B 

Creates a  new file Ctrl +  P 

Prints the document Alt ~ F4 

Closes the document Ctrl + N 

Closes Word application Ctrl + W 



SECTION - B 

IA.c  Tick the right answer. 

1. The area is used for typing and editing text. 

a. Working b. besktop c. bocument 

2. option is used to create a new blank document. 

a. Save b. New c. close 

3. How many scroll bars are there in Word 2016? 

a.1 b.4 c.2 

4. To cJose the Word 2016 application, click on the File tab and select the 

option. 

a. Close b. Exit c. Save 

LB.( Answer in one word. 

1. In what way is MS Word similar to a notebook? 

How is Word 2016 useful to us? 

3. Name the rulers present in the Word 2016 document window. 

4. What does the Title bar contain? 

5. Name any four components of Word 2016 window. 



A 
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Open Word 2016 by clicking on the Start> Word 2016. 

In the work area, type the text as given in the figure. Save the document 

with the name, ' Letter to Mom' using the 5o: button on the Quick Access 

Tool bar. 

Close the document by clicking the  Close  option on the tab drop-down menu. 

Press Ctrl+O key combination to open the document,' Letter to Mom'. 

My loving Mom 

Thank you for allowing me to go for a picnic along with my 

friends. We had a lot of fun. There were different types 

of swings and games. We also danced with mickey Mouse 

and donald buck. 

Yours Lovingly 

Pidhima 

Place the cursor after the word 'friends'. Type hyphen '-' and the names 

of your two friends. Save the file by pressing the key combination Ctrl + 5. 

Change 'm' of mickey and 'd' of donald' into capital letters. Select the 

name Ridhima. Press the belete key and type your name. 

Save the document again by clicking on the button in the drop- 

down menu, and then click on the Close button. 

Learning 
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How to start Tux Paint? 

" Starting a new drawing 

• Parts of Tux Paint window 

• Different tools of Tux Paint and their functions 

• Adding text in a picture 
• Saving and opening a file 

" Tools Bar 

It contains the 

variefy of tools. 

C 

•PI T, Prt 

PantP Stp 

es Sr1,pes 

Te4 Label 

D 

Eraser New 

Open 

'i..Jp and bown Arrows 

Clicking on these 

arrows allows you to 

see more symbols. 

brawing Area/Canvas 

This space is used for 
drawing. 

Selector 

It is also known 
as the Sub-toolbox. 

p.' 

Pick a color or picture with which to start a new drawing. 

Tux Paint Window 

_\ • 
-ep rca 

It gives you tips and details 
about the selected tool. • 

0 

Colors Palette 

It contains the 
different colours. 

C S 

C S 

C S 

The Selector contains two buttons on it-Up and bown arrow buttons.1  

• • S S • S 

S 

S 

S 

• S 

S 

I S • S S S • S S • • I 
• S S S • S S • S S SS

•. . 

. S. 

TUX PAINT 

• S S 

• •. 

• • I 

• I I 

• . S 

Tux Paint is a paint program designed for students. It has many ready-made took 

that help you to make beautiful drawings. 

HOW TO START TUX PAINT? 

Click on the Start button > Tux Paint> Tux Paint (Full Screen) option. You will get the 

window shown below. You can see Tux, the penguin at the bottom of the window. 



S 

Colouring the Drawing 

Learning 
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STARTING A NEW bRAWING 
S S 

: : In Tux Paint, you can insert a ready-made drawing. 

Select the Nevi tool from the Tccs bar. 

You will get the coloured 

backgrounds and Starters for a 

new drawing. 

Click on the bown arrow button 

tYl to see ready-made pictures 

and backgrounds. 

Select the drawing and click on 

Open button or simply double-

click on it. 

Click on the Up arrow 

Click on the Down arrow 
which to strt a new drawing 

Selecting a New Drawing 

The picture appears on the drawing canvas. 

Starter is in page in a colouring book, with black and white outlines of a picture. 
.1 

COLOURING THE bRA WING 

Oce you have inserted a ready-made 

drawing, you can fill colours in it. 

Select the Magic tool in the Tools 

bar. 

• In the Selector bar, click on the Down 

cinrov..'  button tY and select the Fill 

effect option. 

• Select any colour from the Colors 

box. Click on the object where you 

want to fill the colour. 

S 

• • S S S S S S S S S S 
S S S S S S S S S S S S 



) . I 
Click to start drawing a tin.. tat go to co.,I.te t. 

PAINT TOOL 

It is used to paint and draw any thing that 

you like. It is similar to the brushes tool in 

MS Paint. 

When you click on the Paint tool , 

many brushes will appear in the 

Selector. 

Choose any brush pattern and pick any 

colour from the Co coo Palette. 

she 

A • 

0. 
___ e 

Pick a color and a brush shape to draw with. 

41 
The pointer shape changes to Paint brush

Using Paint Tool 

Press the left mouse button and drag. The pattern will be drawn. Now, release the 

mouse button. 

LINES TOOL 

Lines tool (,, is used to draw straight lines and straight patterns. It works quite 

similar to the •°cmt tool .. The  L[oo  tool f has the same brush shapes in the 

sub-toolboxas in the RcCt tool 

Select the LHoo tool . Choose any 

pattern from the sub-toolbox. 

brag the mouse to draw a straight line 

as shown in the given figure. 

Release the mouse button, and you will 

see a straight pattern drawn in place of 

that line. 

Using Lines Tool 

If you draw an inclined line, you will find an inclined pattern. 
J 

S 

. 

o ' 0 0 0 S S S • S S • 
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ERASING THE bRA WING 

The Eraser tool •'! is used to erase any 

unwanted part of the drawing. 

Click on the Eraser tool in the Tools 

bar. 

Select the size of an eraser from the 

Selector box. 

Press and hold down the left mouse button 

and start dragging the pointer on the 

drawing. Observe that the drawing will be 

erased. 
Using Eraser Tool 

AbbING TEXT IN A bRAWING 

Sometimes, you may need to add text in your drawing. In Tux Paint, Text tool is used 

to enter text inyour drawing. 

To enter text in your canvas: 

Select the ra<i tool " in the Tools 

bar. 

Choose a font type from the Letters' 

selector. 

Move the pointer to the canvas. The 

shape of the pointer changes into a 

cursor. 

Click on the canvas and type the text 

that you want to enter in your drawing. 

INSERTING A STAMP 

Choose a style of text. Click on your drawinej and you can start typing. Press (Enter] or 
(Tab] to complete the text. 

Using Text Tool 

A stamp is a sticker that you can paste on a piece of paper. Likewise, Stamp tool in Tux 



There are 22 different shapes available in the sub-toolbox of the Shapes tool. 
I 
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Using Stamp Toot 

41 
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Pick a shape. Click to pick the center, drag, then let go when it is the sire you want. 
Move around to rotate it, and click to draw it. 

[Filled Square 
Shapes tool 

Paint allows you to paste the ready-made pictures on your drawing canvas. Tux Paint 

has a lot of in-built stamps. 

Click on the Stamp tool in the Tools 

bar. 

Select any stamp from the Selector. 

Move the pointer to the canvas. 

Click on the place where you want to paste 

the stamp. 

bRAWING SHAPES 

Tux Paint allows us to draw different shapes using the Shapes tool. The unique 

feature of this tool is Rotation.  A shape can be rotated in a circular direction. Let us 

draw some shapes. 

Click on the Shapes tool in the Took 

bar. 

You will see various filled and unfilled 

shapes in the Selector. 

Select the filled Square shape from 

the Selector. 

Click and drag the mouse pointer on the 

canvas. Using Shapes Toot 

Release the mouse button once you have completed the square. 

The outline of the square will be placed on the canvas with a rotation handle. 

'v  Rotate the shape as per your need. 
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lGrass effect 

Clrck and drag to draw grass. Don't forget the dirt! 

Using Grass Tool 

5toot 

PS Stamp 
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sy 
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Flower tool Dk 

:: Magic toot 

rrntso,tcar  

o!orie •''. . e - • sfl 
Click and drag to draw a flower stalk. Let go to firrislr the flower. 

Using Flower Tool 

NOTE - 

The number of times you click, the same number of flowers will be added on the canvas. 

To apply faded effect on a picture, use the slur tool . 

S 
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MAGIC TOOL 

This tool is used to add magical effects to 

your pictures. 

GRASS TOOL 

It is used to draw grass on your canvas. 

' Click on the Magic tool in the Tools bar. 

Select the Grass effect from the Magic 

sub-tool box. 

Choose dark green colour from the Colors palette. 

4 Either click or drag the mouse pointer to draw grass on the canvas. 

NOTE 

4  Simply clicking on the canvas creates thin grass effect and dragging creates thick 

grass effect. 

  

    

FLOWER TOOL 

It is a tool using which you can draw flowers 

on the canvas. 

Click on the Magic tool in the Tools bar. 

Select the Flower tool 
 we  from the 

Selector. 

Choose red colour from the Colors palette. 

" Bring the Magic wand \ over the canvas 

and click to paste the flower. 



s .  
Do you really Want to quit? 

Yes, I'm done! 

No. take me back! 

If you quit, you'll lose your 
picture! Save it? 

f Yes, save it! 

No. don't bother saving! 

Selector Stamp 

SAVING THE bRA WING 

Click on the Save tool from the Tool bar to save the drawing. 

CLOSING THE TUX PAINT 

Click on the Quit tool . A box will appear. 

Click on Yes button 'I if you want to close 

the file. 

' Click again on ' button 1 if you want 

to save the file before closing.
Open tool 

OPENING THE bRA WING 

Click on the Open tool 

Select the drawing that you want to open. 
Choose the picture you want, then click "Open". 

Using Open Tool 

SECTION - A 

Fill in the blanks with the help of the hints given below. 

1.  The  tool is used to enter text in your drawing. 

2.  A  isastickerthatyoucanpasteonapieceof paper. 

3.  Click on the  tool from the toolbar to save the drawing. 

4. Sub-toolbox is also known as the 

Save Text 

S 
 I 
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a. lemove b. Delete L c. Eraser L 
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 WriteT (True) orF(False). 

1. The Grass tool is used to create flowers on the canvas. 

2. Tux is the name of a duck. 

3. You can choose any picture as the starting background of a file. 

4. The working of Stamp tool and Paint tool is exactly the same. 

5. The Grass effect displays grass only in yellow colour but with the tinge 

of the selected colour. 

S 

S 

SECTION - B 

A. Multiple-choice Questions. 

1. Which tool in Tux Paint is used to draw and give amazing effects to a picture? 

a. Paint tool b. Lines tool c. Magic tool 

2. Which tool is used to open an existing drawing? 

a. Open 

 

b. Start c. Begin 

 

3. How many different shapes are available in the subtool box of the Shapes tool? 

a.17 b.16 c.22 

4. Which among the following tools gives the faded effect to a picture? 

a. Blur 

5. We can rotate a 

a. Shape  

b. Fade 

 in Tux Paint. 

b. Text 

c. bull 

c. Stamp 

6. Which among the following tools removes the unwanted part of a drawing? 
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Answer in one word. 

1. Which tool is used to open an already saved file in Tux Paint? 

• • 

• S S 

• S S 

• S S 

• • S 

S S S 

2. Name the tool that is used to draw shapes in Tux Paint. 

3. Which tool is used to save a drawing? 

4. Name the tool that is used to draw straight patterns. 

5. How is Paint tool similar to Lines tool? 

6. Name the tool that is used to add text in your drawing. 

7. What is the use of a Stamp tool? 
• 

S 

S 

8. How many shapes are available in the sub-toolbox of the Shapes tool? 
S 
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For Students 

raw the following picture using the tools that we have learnt till now. 

Click on the New tool 9' and select white background. Click on the Open 

button'. 

Click on the Shapes tool * Shapes 

Select the filled circle ,. Now, 

draw the circle in the centre of 

the canvas. 

Use the irit toolto draw 

Earth and select Fill tool to 

fill colour in the drawing. 

Click on the Lines tool . and 

divide the Earth into two equal 

parts as shown in the Figure. 

Create eyes using Paint tool . Similarly, draw the half smiling and half sad face. 

On the Left side: 

'- Fill slack colour in the left part of the picture. 

Use the Stamp tool Snp to show the damage using stamps, i.e., fire, smoke, 

vehicles, factory, etc. 

On the Right side: 

Use the Magic and Stamp tools to draw flowers, trees, birds or 

Grass as shown in the Figure. 

s' Now, give caption to your drawing. Write 'Save Our Earth' using the Text 

tool. 

SavethefilebyclickingontheSavetool . 

Learning Kps Computers with 67 
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Chapters 5-7 
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1. The key combination is used to create a new document. 

2. The tab is placed at the upper left corner of the Word 2016 window. 

3. We can erase a picture using an  tool. 

4. We should not press the key at the end of each line. 

5. The  is the top most bar of the Wordpad window. 

   

• Enter Eraser Ctrl~N Quick access toolbar Title bar 

   

    

    

.  WriteT(True) or(False). 

1. A curve can be modified only three times. 

2. The Quick Access Toolbar is placed below the Title bar. 

3. The standard keyboard has 108 keys. 

4. The shortcut key to print a document is Ctrl+T 

C. Match the following tools of Tux Paint with their correct images. 

Shapes tool 

Magic wand 

Stamp tool 

Lines tool e 
b. Label the listed parts of Word 2016 Window. 

1.  

S 

2.  
a 

3.  

4. 
I 

a 

5. 
a 

I 

a 
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WORKSHEET 

Chapters 5-7  E— 

A.  Choose the right answer. 

1. Which tool is used to paste the ready-made pictures on drawing canvas. 

a. Stamp b. Image 

2. Which tool is used to enter text in your drawing? 

a. Text b. Polygon 

3. How many buttons are in the Tux Paint Selector? 

a. Two b. Three 

4. Which tool is used to select the size of an eraser? 

a. Selectorbox  b. ColorPulette 

5. How many scroll bars are there in Word 2016? 

a.2 b.3 

B. Answer in one word. 

1. Write the shortcut key to save the Word document  

2. Name the option used in MS Word to close a document?  

3. Name the two rulers present in the Word 2016 document Window 

4. Which button in Tux Paint is used to start a new drawing?  

5. Which key is used to erase the text from a word document?  

C. Answer the following questions. 

1. How is Word 2016 useful to us? 

2. Which key brings the cursor to the next line? 

3. What is the use of Work Area in MS Word? 

4. What is Tux Paint? 

5. Write the names of different parts of Tux paint window. 

c.Shapes 

c. Magic 

c. One 

c. Paint tool 

c.4 
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Stamp tool 

Shape tool 

Fill tool 

Line tool 

Project - 2 

Stamp tool 

Shape tool 

Fill tool 

Magic tool 

Paint tool 
- 

a 
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• • 

• S 

• S 
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S 
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Tux Point 
braw and colour the following sceneries in Tux Paint: 

Project-I 
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IS 
________ S IS 

Project- 3 
IS 

Project -4 

Stamp tool 

Text tool 

Line toot 

Fill tool 

Paint tool 

0 

I 

S 

S S S S S S S S S S S S 
S S S S S S S S S S S 

I. 
S 

S 

Stamp toot 

Shape tool 

Fill tool 

Paint tool 

S 

S 

S 
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Project: Open MS Word and make a beautiful poster on 'Our Parents'. 

Our Parents 
We are in this worCc( because 

of our T4R'J'iTS! 
Parents always wish their children to surpass them in all lields. 

Parents take pains to lrin6 happiness to their children. 

Parents are like GOD. 

REMEMBER: We must respect our Parents throughout 

their LIVES. 

(INsTRUcTIoNs) 

Click on the File tab> New> Blank Document button. 

Move the mouse pointer inside the document and type the text as shown in the 

poster. 

Select the text "Our Parents" and change its Font: Cooper Black, Font size: 

20 pt and Font Color: Ied by selecting the Font group on the Home tab. 

Select the text "We are  PAENT5" and change its  Font: Lucida 

Calligraphy, Font Size: 18 Pt and Font Color: Black. 

Type the points given in the poster and change its Font: Poor ichard Black, 

Font size: 16 pt. 

Type the last sentence as shown in the poster and change its Font: Calibry, 

Font size: 18 Pt and Font Color: ed. 

S • S S S 4 
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